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part 3 

XVI. Saving and Recording movies 

The Save Movie Wizard lets you quickly save your project as a final movie. The timing, 

layout, and contents of the project are saved as one complete movie. You can save and 

store the movie on your computer or on a recordable CD, or you can send it as an 

attachment in an e-mail message or to a video hosting provider on the Web. In addition 

to these choices, you can choose to record your movie to a tape in a DV camera. 

This page of the Save Movie Wizard lets you select which movie saving option you 

want to use, depending on what you want to do with the final movie. The following 

options appear on this page. 

My computer 

Specifies that you want to save your movie to your local computer or to a shared 

network location. 

Recordable CD 

Specifies that you want to save your movie to a recordable or rewriteable CD (CD-R or 

CD-RW). Choose this option if you have a rewriteable or recordable CD drive attached 

to your computer and you want to save your final movie to a recordable or rewriteable 

CD.  

E-mail 

Specifies that you want to save your movie as an attachment to send in an e-mail 

message. Choose the option to share smaller movies with others by sending them in e-

mail by using your default e-mail program. 

The Web 

Specifies that you want to save your movie and then send it to a video hosting provider 

on the Web. A video hosting provider is a third-party provider on the Web that provides 

a Web server location and hosts the movies you save in Windows Movie Maker. Choose 
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this option if you want to save your movie so family and friends can watch your movie 

on the Web. 

DV camera 

Specifies that you want to send your movie to a tape in your DV camera. This option is 

available when you have a DV camera connected to an IEEE 1394 port. Choose this 

option if you want to save your movie to a tape so you and others can watch it on the 

DV camera or on a TV (when you connect the camera to a TV). 

Saving a movie to My computer 

The My computer saving option lets you save your movie for playback on your local 

computer. When you select this option, the final movie is stored in the specified location 

on your computer or on a shared network location. 

If you click the My computer option, the Save Movie Wizard proceeds as follows.  

1. Specify a movie file name and place for your movie to be saved. For more 

information about choosing a saving destination, see Naming the saved movie 

file.  

2. Choose a movie setting for saving your movie. For more information about 

choosing the appropriate movie setting when saving a movie, see Choosing a 

movie setting.  

3. Wait for your movie to be saved. For more information about monitoring the 

saving progress of your movie, see Saving your movie for local playback.  

4. Complete the Save Movie Wizard. For more information, see Completing the 

Save Movie Wizard when saving to My computer.  

To save a movie on your computer 

1. On the File menu, click Save Movie File, and then click My computer.  

–or- 

In the Movie Tasks pane, under Finish Movie, click Save to my computer. 

2. In the Enter a file name for your saved movie box, type a name for your 

movie.  

3. In the Choose a place to save your movie box, do one of the following:  
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• Choose the path and folder name from the list of available places in the 

drop-down box.  

• Click Browse to choose a new place that is not already listed in the drop-

down box.  

• To create a new folder, click Make New Folder in the Browse For File 

dialog box, and then type a name for the new folder.  

4. On the Movie Setting page, do one of the following:  

• To use the default movie setting, click Best quality for playback on my 

computer (recommended). The specific setting details, such as the file 

type, bit rate, display size, aspect ratio, and frames per second displayed 

in the video, are shown in the Setting details area.  

• To use a different movie setting, click Show more choices, and then 

choose another movie setting from the list.  

5. If you want to watch your movie after completing the wizard, select the Play 

movie when I click Finish check box.  

6. After the movie is saved, click Finish.  

Saving your movie for local playback 

This page of the wizard indicates the saving progress of your movie when you choose to 

save your movie to your computer. The amount of time the movie takes to save depends 

on a few factors related to your movie and your computer.  

• Length of your movie. The time it takes for your movie to be saved increases in 

proportion to the length of your movie. For example, a movie that is only one or 

two minutes long takes less time to save than a movie that is 15 minutes long 

(assuming the same movie setting is selected for both). Therefore, if you have a 

movie that is an hour in length, the amount of time it takes to save the movie can 

be significant.  

• Movie setting. The time it takes for your movie to be saved also increases if you 

choose a higher quality setting for saving your movie. For example, it takes less 

time to save a movie with a movie setting that displays the video at 160x120 

pixels than to save the same movie with a movie setting that displays the video at 

640x480 pixels (at the same bit rate).  

• System resources of your computer. The amount of time it takes to save a 

movie also depends on the processor speed and other system resources on your 

computer. Other system resources that can also affect the time it takes to save a 

movie include the amount of RAM on your computer and the speed of your hard 
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disk. For example, assuming other system specifications on your computer are 

equal and the same movie setting is selected, it will take longer to save movie on 

a computer that has a processor speed of 600 megahertz (MHz) than on a 

computer with a processor speed of 1.5 gigahertz (GHz) or more.  

Completing the Save Movie Wizard when 

saving to My computer 

This page of the Save Movie Wizard lets you complete and close the wizard.  

The following option appears on this page. 

Play movie when I click Finish 

Specifies whether the final movie plays in your default player after you click Finish. For 

example, if your default player is Windows Media Player and you select this check box, 

the Player will start automatically and you can watch your movie. 

Troubleshooting saving a movie to My 

computer 

Movie file exceeds the FAT32 4-gigabyte size limit 

The movie file created when you are saving your movie on your computer exceeds the 

4-gigabyte (GB) file size limit supported by the FAT32 file system. This message occurs 

if you are saving a longer movie file at a higher quality setting on a volume or partition 

that is using the FAT32 file system. The file system is used by MS-DOS and other 

Windows-based operating system to organize and manage files. 

To address this issue, do one or more of the following:  

• Reduce the length of your movie by removing items from the 

storyboard/timeline in Windows Movie Maker.  

• Choose a lower movie setting when saving your movie.  

• If your computer hard disk has multiple partitions, and one is formatted using the 

NTFS file system, go back in the Save Movie Wizard, and then save your movie 

to that partition. The NTFS file system supports files larger than 4 GB.  
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• If you are saving your movie to tape and you have multiple partitions on your 

hard disk, and one partition is formatted using the NTFS file system, specify this 

drive as the temporary storage location in the Options dialog in Windows Movie 

Maker (on the Tools menu, click Options).  

• Convert your file system to use the NTFS file system. The NTFS file system 

supports files larger than 4 GB.  

For more information about converting a volume to use NTFS, see the topic "To 

convert a volume to NTFS from the command prompt" in Windows Help and 

Support. 

Not enough disk available free disk space 

There is not enough free disk space available to save your movie. This occurs when the 

movie file size exceeds the amount of free disk space that is available. 

To address this issue, do one or more of the following:  

• Reduce the length of your movie by removing items from the 

storyboard/timeline in Windows Movie Maker.  

• Choose a lower movie setting when saving your movie.  

• Save the movie to a location that has more available disk space.  

Movie file saving destination does not exist 

The specified destination for the saved movie file does not exist. This can occur if you 

chose to save the movie to a removable storage drive and the drive is disconnected or 

not available. This issue may also occur if you chose to save your movie to a network 

drive and that destination is not available. 

To address this issue, do one or more of the following:  

• If you specified a removable storage drive as the saving destination, verify that 

the device is properly connected to your computer and that the drive or 

removable media is still available.  

• If you specified a network drive as the saving location, make sure that the 

network cable for your computer is attached properly and that the networked 

computer to which you are saving your movie to is still available.  

• Specify a saving destination on your computer hard disk.  
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Source files for movie not found 

One or more source files cannot be found. Therefore, the movie cannot be saved 

successfully. This can occur if you try to save a movie after one or more of the source 

files for the corresponding clips in your project have been moved, renamed, or deleted. 

To address this issue, do one or more of the following:  

• Locate the original source file, and move or copy it to the location on your 

computer when it was first imported into Windows Movie Maker.  

• Verify that any network locations are still available if the source file was 

originally located on a shared network location when it was first imported into 

Windows Movie Maker.  

Saving a movie to a recordable CD 

The Recordable CD saving option lets you save your movie for playback on a 

recordable or rewriteable CD (CD-R or CD-RW). When this option is selected, the final 

movie is saved to a recordable or rewriteable CD in the Save Movie Wizard. 

In Windows Movie Maker, movies saved to a recordable CD are saved by using 

Microsoft HighMAT™ technology. A HighMAT (High-performance Media Access 

Technology) CD can contain audio, video, and pictures. HighMAT-compatible 

consumer electronic devices recognize how the content is organized on the CD, and 

enable users to play content using the displayed menus. The recordable CD can be 

played back on a computer as well. For more information about HighMAT, see the 

Microsoft Web site. Consumer electronic devices that can play back HighMAT CDs 

created in Windows Movie Maker have the following logo. 

 

You can choose to save one or more movies to a recordable CD, which typically holds 

up to 650 MB. Therefore, you may have one large movie or several smaller movies on 

the same CD. You can save several movies to the same recordable or rewriteable CD at 

different times. This lets you add more movies to a recordable CD as you create and 

save more movies at different times in Windows Movie Maker 
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If you click the Recordable CD option, the Save Movie Wizard proceeds as follows.  

1. Specify a movie file name and CD name. For more information about entering a 

movie file and CD name, see Naming the saved movie file.  

2. Choose a setting for saving your movie. For more information about choosing 

the appropriate setting when saving a movie to a recordable CD, see Choosing a 

movie setting.  

3. Wait for your movie to be saved. For more information about monitoring the 

progress for saving a movie to a recordable CD, see Saving a movie for playback 

on a recordable CD.  

4. Complete the Save Movie Wizard. For more information, see Completing the 

Save Movie Wizard when saving a movie to a recordable CD.  

To save a movie to a CD-R or CD-RW 

1. On the File menu, click Save Movie File, and then click Recordable CD.  

–or- 

In the Movie Tasks pane, under Finish Movie, click Save to CD. 

2. In the Enter a file name for your saved movie box, type a name for your 

movie.  

3. In the Enter a name for the CD box, type a name for the CD.  

4. On the Movie Setting page, do one of the following:  

• To use the default movie setting, click Best quality for recordable CD 

(recommended). The specific setting details, such as the file type, bit 

rate, display size, aspect ratio, and frames per second displayed in the 

video, are shown in the Setting details area.  

• To use a different movie setting, click Show more choices, and then 

choose another movie setting from the list.  

5. To save the movie to another recordable CD, select the Save this movie to 

another recordable CD. Replace the recordable CD with another, and then 

repeat steps 2 through 4.  

6. If the CD is not ejected automatically from the recordable CD drive, press the 

eject button on the recordable CD drive.  

Saving a movie for playback on a 

recordable CD 



Budi Setyono                                                  Membuat Movie Dengan Windows Movie Maker, 87/27 

This page of the wizard indicates the saving and copying progress of your movie when 

you choose to save your movie to a recordable CD. The amount of time the movie takes 

to be saved and copied depends on a few factors related to your movie, computer, and 

recordable CD drive.  

• Length of your movie. The time it takes for your movie to be saved increases in 

proportion to the length of your movie. For example, a movie that is only one or 

two minutes long takes less time to save than a movie that is 15 minutes long 

(assuming the same movie setting is selected for both). Therefore, if you have a 

movie that is an hour in length, the amount of time it takes to save the movie can 

be significant.  

• Movie setting. The time it takes for your movie to be saved also increases if you 

choose a higher quality setting for saving your movie. For example, it takes less 

time to save a movie with a movie setting that displays the video at 160x120 

pixels than to save the same movie with a movie setting that displays the video at 

640x480 pixels (at the same bit rate).  

• System resources of your computer. The amount of time it takes to save a 

movie also depends on the processor speed and other system resources on your 

computer. Other system resources that can also affect the time it takes to save a 

movie include the amount of RAM on your computer and the speed of your hard 

disk. For example, assuming other system specifications on your computer are 

equal and the same movie setting is selected, it will take longer to save movie on 

a computer that has a processor speed of 600 megahertz (MHz) than on a 

computer with a processor speed of 1.5 gigahertz (GHz) or more.  

• Recording and writing speed of your recordable CD drive. The amount of 

time it takes to write your movie to the recordable CD after the movie has been 

saved depends on the speed of your CD recorder.  

Completing the Save Movie Wizard when 

saving a movie to a recordable CD 

This page of the Save Movie Wizard lets you complete and close the wizard. For a 

majority of recordable CD drives, the CD is ejected automatically after you click Finish 

to close the wizard. 

The following option appears on this page. 

Save this movie to another recordable CD 
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Click to save a copy of your movie on another CD. When saving to a recordable CD, 

this option is cleared by default. By selecting this check box, you can choose to repeat 

the steps in the Save Movie Wizard to save the movie to a different CD. 

Troubleshooting saving a movie to a 

recordable CD 

Recordable CD drive not detected 

A recordable CD drive was not detected on your computer. This error occurs when you 

try to save your movie to a recordable CD drive that cannot be found. 

To address this issue, do one or more of the following:  

• Verify that the recordable CD drive is connected properly to your computer, 

powered on, and that any necessary software drivers are installed.  

• If you have an external recordable CD drive, restart the CD drive.  

To restart an external CD drive, do the following: 

1. Close the Save Movie Wizard, save any changes to your project, and then 

close Windows Movie Maker.  

2. Double-click the Safely Remove Hardware icon (which appears in the 

lower right hand corner of the screen by default on the System Tray), 

select the recordable CD drive, and then click Stop.  

3. Choose the recordable CD drive in the Stop a Hardware Device dialog 

box, and then click Close in the Safely Remove Hardware dialog box.  

4. Turn the recordable CD drive off, and then turn it on again.  

5. Start Windows Movie Maker and try saving your movie to the recordable 

CD again.  

• Verify that the CD in the recordable CD drive is a new, blank CD-R or CD-RW 

disc.  

• End the Imapi.exe process in Windows Task Manager or restart Windows.  

To stop the imapi.exe process, do the following: 

1. Close the Save Movie Wizard, save any changes to your project, and then 

close Windows Movie Maker.  
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2. To open Windows Task Manager, right-click an empty space on the 

taskbar, and then click Task Manager.  

3. In the Windows Task Manager dialog box, select the Processes tab, 

select the process imapi.exe, and then click End Process.  

4. Close Windows Task Manager.  

5. Start Windows Movie Maker, open the saved project, and then try saving 

your movie to a recordable CD again using the Save Movie Wizard.  

Note  

• To see and end the imapi.exe process in Windows Task Manager, you must have 

the appropriate Administrator permissions. If your login account does not have 

Administrator permissions, you cannot end the process. In this situation, close 

Windows Movie Maker, restart Windows, and then try saving your movie to a 

recordable CD again.  

Recordable CD drive not enabled for recording CDs 

CD recording for your recordable CD drive has been disabled. This error occurs if the 

Enable CD recording on this drive check box has been cleared for the CD recorder 

drive properties. 

To address this issue, do one of the following:  

• Contact your system administrator to enable CD recording on the recordable CD 

drive, and then try saving the movie to a recordable CD again.  

• If your login account has Administrator permissions, do the following:  

1. Close the Save Movie Wizard, save any changes to your project, and then 

close Windows Movie Maker.  

2. Open My Computer.  

3. Select the recordable CD drive.  

4. On the File menu, click Properties.  

5. In the Properties dialog box, click the Recording tab, and then select the 

Enable CD recording on this drive check box. Click OK.  

6. Start Windows Movie Maker, open the saved project, and then try saving 

your movie to a recordable CD again.  

Permission denied for recording CDs 

You do not have the required permissions to copy to a recordable CD. This error occurs 

if the Remove CD Burning features setting is set to Enabled by the system 
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administrator in Group Policy. This is done by some companies or organizations to 

increase security. 

To correct this problem, do one the following:  

• Contact your system administrator to set the appropriate permissions that enable 

you to copy to a recordable CD, and then try saving the movie to a recordable 

CD again.  

Note  

• To see and make changes in Group Policy, you must have the appropriate 

Administrator permissions.  

No recordable CD 

A recordable or rewriteable CD is not inserted in the recordable CD drive. This error 

occurs if a recordable CD is not inserted in the recordable CD. To correct this problem, 

insert a recordable or rewriteable CD that your movie can be saved to, and then continue 

saving your movie. 

CD is not recordable or rewriteable 

The CD in the recordable CD drive is not recordable or rewriteable. This error occurs is 

the CD in the recordable CD drive is not a recordable (CD-R) or rewriteable (CD-RW) 

CD. 

To correct this problem, do the following:  

1. Remove the current CD from the recordable CD drive.  

2. Insert a recordable (CD-R) or rewriteable (CD-RW) CD in the recordable CD 

drive (depending on your recordable CD drive).  

3. Continue saving your movie in the Save Movie Wizard.  
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Recording a movie to a DV camera 

The DV Camera saving option lets you record the movie you create to a tape in a DV 

camera through Windows Movie Maker. This lets you or others watch the final movie 

on a DV camera or on TV when you connect the camera to a TV. When you choose this 

option, the movie is recorded to the tape in your DV camera, so it appears on the tape 

with existing video you might have recorded back to tape or recorded with your DV 

camera. 

To record your movie to tape, your DV camera needs to be in the playback mode (often 

labeled VCR or VTR on your camera). 

If you click the DV Camera saving option, the Save Movie Wizard proceeds as follows.  

1. If you have more than one DV device connected to your computer and powered 

on, select the DV device on the DV Camera page that contains the tape that you 

want to record your movie to. For more information about choosing a DV 

device, see Choosing a DV device.  

2. Set your camera to playback mode, and then rewind or fast-forward the tape to 

the point where you want your movie to be recorded. For more information 

about cuing your tape, see Cuing your tape.  

3. Wait for your movie to be created and then recorded to tape. For more 

information about recording a movie to tape, see Recording to tape.  

4. Complete the Save Movie Wizard. For more information, see Completing the 

Save Movie Wizard when recording to tape.  

Note  

• In addition to recording a movie to tape in a DV camera, you can also record 

movies to a tape in a Sony Digital8 Handycam or Hi8 Handycam cameras.  

To record a movie back to tape 

1. Switch your DV camera on and verify that it is in playback mode (often labeled 

VCR on the camera).  

2. On the File menu, click Save Movie File, and then click DV camera.  

–or- 

In the Movie Tasks pane, under Finish Movie, click Send to DV camera. 
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3. If you have more than one DV device powered on and detected by Windows 

Movie Maker, on the DV Camera page, choose the DV device that contains the 

tape you want to record your movie to.  

4. On the Cue Your Tape page, using the transport controls on your camera, 

rewind or fast-forward the tape to the point where you want your movie to be 

recorded.  

Caution 

• You should verify that you are not overwriting a portion of the tape that 

contains content you want to keep.  

5. In the Windows Movie Maker dialog box, click Yes to continue in the wizard.  

Wait for your movie to be created and recorded to tape. The time it takes to 

create and record the movie to tape depends on the length of the movie and the 

system resources on your computer. You can preview the movie in the LCD 

display of your DV camera as your movie is recorded to tape. 

6. On the Completing the Save Movie Wizard page, click Finish.  

To copy a movie on DV tape to an analog tape 

1. Connect your DV camera to your VCR, often by using one of the following 

configurations:  

• Composite (RCA) inputs. Connect the DV camera and VCR through a 

connection that uses RCA-style connectors. The composite Video and 

Audio Out (many times this is one input on a DV camera) are connected 

to the composite Video In input (which is yellow) and Audio In left and 

right inputs (which are white and red, respectively) on the VCR. Many 

times, these inputs are located on the front of many VCRs today.  

• S-video. Connect the DV camera and VCR through a connection that 

uses RCA-style connectors for the audio and S-video for the video. The  

right and left Audio Out input (many times, this is one input) are 

connected to the Audio In left and right inputs (which are white and red 

respectively) on the VCR while an S-video cable is connected to the DV 

camera and VCR to record the video (if your VCR has an S-video 

connector).  

2. Using the transport controls on the DV camera, fast-forward or rewind to the 

point of the tape where you want to begin recording to the tape in the VCR.  
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3. Using the transport controls on the VCR, fast-forward or rewind to the point of 

the tape where you want to begin recording the content from the DV camera to 

the tape in the VCR.  

Caution 

• Make sure the tape in the VCR does not contain any video you want to 

save. It will be overwritten with the content on the DV tape.  

4. Set the VCR to record from the appropriate video and audio inputs. For complete 

information about recording from the appropriate input, see the documentation 

provided with your VCR.  

5. Press Record on the VCR to begin recording.  

6. Press Play on the DV camera to begin playing back the movie.  

7. Press Stop on the VCR to stop recording.  

8. Press Stop on the DV camera to stop playback.  

Note  

• Using this configuration lets you share your movies with others and watch the 

movie on a TV. The configuration you use to connect your DV camera to your 

VCR depends on your specific camera and VCR. Many VCR manuals contain 

specific information about how to connect a VCR to a video camera 

Choosing a DV device 

This page of the Save Movie Wizard only appears if you have two or more DV devices 

powered on and detected by Windows Movie Maker after clicking the DV camera 

option to record your movie to tape. You can then choose the DV device that contains 

the tape you want to record your movie to. 

Cuing your tape 

This page of the Save Movie Wizard prompts you to cue your tape to the point you want 

to start recording your movie. You can use the transport controls on your DV camera to 

do this. 

Caution  
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• Before you begin recording, make sure the tape or part of the tape you want to 

record your movie to do not contain any video that you want to save. When 

recording to tape, the existing video and audio content on the tape is overwritten 

and lost, and the video and audio of the movie you created in Windows Movie 

Maker appears on the tape.  

Recording to tape 

This page of the Save Movie Wizard indicates the progress of recording your movie to 

the tape in your DV camera. During this part of the process, Windows Movie Maker 

creates a temporary movie file and then records the movie to the tape. You can watch 

the progress of the movie as it is recorded to tape on the LCD display of your camera as 

the movie is recording to tape. 

Note  

• After your movie is created and recorded to the tape, the temporary movie file is 

deleted automatically. If you want to save a copy of your movie on your 

computer as well, restart the Save Movie Wizard after your movie is recorded to 

the tape, and then choose the My computer saving option. For more information 

about saving your movie to the hard disk on your computer, see Saving a movie 

to My computer.  

Completing the Save Movie Wizard when 

recording to tape 

This page of the Save Movie Wizard lets you complete and close the wizard. 

Troubleshooting recording a movie to DV 

tape 

No DV device found 

A DV device, such a DV camera, was not detected on your computer so your movie 

cannot be recorded to tape. You may encounter this error for the following reasons.  
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• The DV camera is not powered on.  

• The DV camera went into standby mode. Some DV cameras will go into standby 

mode if the DV camera is in the record (Camera) mode with a tape in it and no 

video or audio is sent to or from the camera.  

To fix the problem, do one or more of the following, and then try again:  

• Verify that the DV device is connected properly to your computer using an IEEE 

1394 cable.  

• Verify that the DV camera is powered on and in playback mode.  

• Switch the DV camera off and then on again to playback mode.  

DV camera does not support DV In 

Your DV camera does not support DV In. You may encounter this error if your DV 

camera does not support DV In, which means that captured video cannot be sent from a 

computer or other device to the DV camera. 

Check the documentation for your DV camera to see if DV In is supported for your 

camera. 

Switch DV camera to VCR mode 

The DV camera needs to be in playback (usually labeled VCR or VTR on the camera) 

mode to record your movie from your computer to DV tape.  

The following illustration shows a typical control on a DV camera that is used to switch 

the camera between camera mode and playback mode. 

 

To fix the problem, do one or more of the following, and then try again:  

• Verify that the DV camera is powered on and in playback mode.  

• Verify that the DV device is connected properly to your computer using an IEEE 

1394 cable.  

• Switch the DV camera off for a few seconds and then on again to playback 

mode.  



Budi Setyono                                                  Membuat Movie Dengan Windows Movie Maker, 96/27 

No tape in DV camera 

Your movie cannot be recorded to tape because there is no tape in your DV camera. 

To fix this problem, insert a writeable DV tape into the camera, and then try to record 

your movie to tape again. 

DV tape is write-protected 

The tape in your DV camera is write-protected and your movie cannot be recorded to it.  

The following illustration shows a DV tape with write-protection removed so a movie 

can be recorded to the tape. 

 

To fix the problem and record your movie to tape, do the following:  

1. Eject the tape from your DV camera.  

2. Move the write-protection tab on the tape from SAVE to REC.  

3. Insert the tape in the DV camera.  

4. Make sure the tape does not contain any video you want to save, and then try 

recording to tape again.  

First seconds of movie recorded to tape are missing 

The first few seconds of your movie may not be recorded successfully to tape. This 

problem occurs if a DV camera does not start quickly enough when recording a movie 

to tape in Windows Movie Maker. In this situation, Windows Movie Maker begins 

sending the video to the camera before the camera is ready to begin recording to tape. 

This causes the first few seconds of the movie to not be recorded correctly. 

To work around this issue, do the following:  

1. Click Start, point to All Programs, point to Accessories, and then click Paint.  

2. On the Image menu, click Attributes.  

3. In the Units area, click Pixels.  

4. In the Width box, type 320. In the Height box, type 240.  

5. In the toolbox, click Fill With Color, and then choose black as the fill color.  
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6. On the File menu, click Save. In the File name box, type a name for your image, 

and then click Save.  

7. Open Windows Movie Maker, import the picture you just created and add it to 

the beginning of the storyboard/timeline so it appears for a few seconds in your 

movie.  

8. Record your movie back to tape by choosing the DV camera option in the Save 

Movie Wizard.  

When your movie is recorded back to tape, the first few frames of missing video on the 

tape will be blank, black frames and the movie on the tape should begin with the actual 

content of your movie. 

Entire movie may not fit on tape if recording in SP mode 

The entire movie may not fit on the tape if you are recording in SP mode. This message 

occurs if the video or audio on the storyboard/timeline is longer in duration, such as 

greater than 90 minutes. 

When recording your movie to DV tape, there are basic recording modes that determine 

the amount of video you can record to a DV tape. The two basic recording modes are SP 

and LP. When recording in SP mode, the tape speed is faster when compared to 

recording in LP mode. Though the quality of the recorded video is increased, the amount 

of video and audio that can be recorded to the tape is decreased. 

To fix the problem, do one or more of the following:  

• Reduce the length of your movie by removing items from the 

storyboard/timeline in Windows Movie Maker.  

• On the DV camera, set the record mode to LP. For more information about 

switching the recording mode on your DV camera to LP, see the documentation 

associated with your DV camera.  

Temporary movie file exceeds the FAT32 4-gigabyte size limit 

The temporary movie file created when you are recording your movie to tape on a DV 

camera (or movie file saved on your computer when choosing a different movie 

location) exceed the 4-gigabyte (GB) file size limit supported by the FAT32 file system. 

This message occurs if you are saving a longer movie file at a higher quality setting, 

such as when you save a movie as a DV-AVI file and when you choose to record your 

movie to tape, on a volume or partition that is using the FAT32 file system. The file 
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system is used by MS-DOS and other Windows-based operating system to organize and 

manage files. 

To fix this problem, do one or more of the following:  

• Reduce the length of your movie by removing items from the 

storyboard/timeline in Windows Movie Maker.  

• If your computer hard disk has multiple partitions, and one is formatted using the 

NTFS file system, go back in the Save Movie Wizard, and then save your movie 

to that partition.  

• If you are saving your movie to tape and you have multiple partitions on your 

hard disk, and one partition is formatted using the NTFS file system, specify this 

drive as the temporary storage location in the Options dialog box in Windows 

Movie Maker (on the Tools menu, click Options).  

• Convert your file system to use the NTFS file system which does not have a file 

size limit.  

To fix this issue, do the following:  

1. Save your current project in Windows Movie Maker and then close Windows 

Movie Maker.  

2. Close any open applications.  

3. Convert your file system to use the NTFS file system. For more information 

about converting a volume to use NTFS, see the topic “To convert a volume to 

NTFS from the command prompt” in Windows Help and Support.  

Naming the saved movie file 

This page of the Save Movie Wizard provides information about where you want to save 

your movie. This page appears when you choose either the My computer, Recordable 

CD, or The Web saving option. 

The following options appear on this page. 

Enter a file name for your saved movie 

Provides a space for you to enter a file name for your movie. The maximum number of 

characters for the file name is 64. 
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When naming and saving a movie you are going to send in an e-mail message or to the 

Web, use the characters A through Z (uppercase or lowercase), the numbers 0 through 9, 

and the period (.) in the movie file name. Some Web servers and proxy servers can only 

understand these characters.  

The following characters cannot be used in the movie file name: < > * ? / \ | ; = + [ ] ( ) " 

: 

Choose a place to save your movie 

Specifies the location to which you want to save your movie. This option appears when 

you choose the My computer saving option. To change the place the movie is saved to, 

either click one of the places in the drop-down box or click the Browse button, and then 

choose the new place for the saved move in the resulting dialog box. The destination 

you can select is specified in the following ways. 

If you chose the My computer saving option and want to save the movie to your hard 

disk, the format Drive:\FolderName, where Drive is a drive on your computer and 

FolderName is a name of a folder on the specified drive is used. If the path and folder is 

not listed in the drop-down box, you can click Browse to find a folder or create a folder. 

For example, if you want to save your movie to a folder named Movies on your drive C, 

you would select C:\Movies. 

If you chose the My computer saving option and you want to save the movie to a 

shared computer, the format \\Servername\Sharedfolder, where Servername is the name 

of the shared computer, and Sharedfolder is the name of the shared folder is used. 

For example, if the shared computer named SharedComputer has a shared folder named 

SavedMovies, you would select \\SharedComputer\SavedMovies. 

Enter a name for the CD 

Provides a space for you to enter a name for the CD. This option appears when you 

choose the Recordable CD saving option. 

The name of the CD helps to identify the CD. This name appears in Windows Explorer 

or My Computer when the final CD is loaded into a CD-ROM drive. The maximum 

number of characters for the CD name is 16. 

By default, the name of the CD is first entered automatically according to file name you 

enter for the saved movie. However, you can edit the name for the CD as well. 
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Choosing a movie setting 

This page of the Save Movie Wizard lets you choose what settings you want to use 

when saving your movie using the My computer or Recordable CD movie setting. The 

movie setting you choose determines the quality and file size of the saved movie file. As 

the video display size and video bit rate increase with higher movie settings, so does the 

file size. Likewise, a higher movie setting and bit rate results in a larger file size. When 

choosing the movie setting, consider file size along with how you plan to share your 

saved movie. 

The following is a listing of the options displayed on this page of the Save Movie 

Wizard. 

Best quality for playback on my computer (recommended) 

Specifies that you want to save your movie at the recommended movie setting. This 

movie setting encodes the video at a higher quality setting. The specific movie setting 

that is selected is determined by the original quality of the video and audio content on 

the storyboard/timeline. This option appears when you choose the My computer saving 

option.  

This setting is well-suited for a majority of the movies you save to your computer. 

Best fit for recordable CD (recommended) 

Specifies that you want to save your movie to a recordable CD at the recommended 

movie setting. This movie setting encodes the video at a higher quality setting. The 

specific movie setting that is selected is determined by the original quality of the video 

and audio content on the storyboard/timeline, as well as by the amount of available 

space on the recordable CD and in the specified temporary storage location. This option 

appears when you choose the Recordable CD saving option.  

This setting is well-suited for a majority of the movies you save to a recordable CD. 

Show more choices 

Click to see additional movie settings.  

Best fit to file size 
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Specifies that the saved movie should fit to a specified file size. When this option is 

selected, the settings that are used for saving the movie are determined by Windows 

Movie Maker. The movie is then saved at a setting where the resulting movie will be at 

or below the specified file size. 

This setting is ideal if you have a file size requirement or limit for your final movie file. 

To increase the quality of the final movie file size, you can specify a larger file size 

limit. This lets Windows Movie Maker use a higher movie setting to save the movie 

compared to if you specify a lower file size limit with the same content on the 

storyboard/timeline. 

Other settings 

Provides a list of additional movie settings you can choose to save your movie with. 

When choosing a setting from this list, consider how you plan to share the final movie. 

This list ranges from movie settings suited for video on a Pocket PC to video suited for 

local playback which is saved at a high bit rate and movie setting.  

Setting details 

Displays the settings for the saved movie file at the current setting. The following details 

are provided: 

File type. The type of file the movie file is saved as on your computer. Possible file 

types include Windows Media Video (WMV) files or Audio-Video Interleaved (AVI) 

files. 

Bit rate. The total bit rate of the saved video and audio. Typically, a higher bit rate will 

result in higher-quality video with smoother motion. However, as the bit rate increases, 

so does the video file size. 

Display size. The size the video displays at (in pixels) in your movie. The first number 

indicates the width of the video, while the second number indicates the height of the 

video. 

Frames per second. The number of frames that are displayed per second in the saved 

movie file. Typically, a higher number or frames per second will make the motion of 

objects or persons in your video appear smoother. 

Video format. The video standard for the saved video file. The two possible formats are 

NTSC and PAL. The specific video format depends on the selected video capture device 
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and the video format it uses. This value is displayed when capturing video as a DV-AVI 

video file. 

Movie file size 

Provides the estimated file size of the saved movie and the required available space 

needed on your hard disk (when saving to your computer) or on the recordable CD 

(when saving to a recordable CD) to store the saved movie file. The estimated amount of 

disk space consumed by the movie file is displayed in this area and determined by the 

length of the movie and the selected movie setting. 

For movie settings that are based on the quality of the saved movie, a file size estimate 

is not available because the size of the movie varies depending on the contents of the 

timeline and the selected movie setting. 
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System requirements 

Windows Movie Maker requires the following minimum system configuration:  

• Microsoft Windows XP Home Edition or Windows XP Professional  

• A 600 megahertz (MHz) processor, such as an Intel Pentium III, Advanced 

Micro Devices (AMD) Athlon, or equivalent processor  

• 128 megabytes (MB) of RAM  

• 2 gigabytes (GB) of free hard disk space  

• An audio capture device (to capture audio from external sources)  

• A DV or analog video capture device (to capture video from external sources)  

• An Internet connection (to save and send a movie to the Web or to send a movie 

as an attachment in an e-mail message)  

To optimize the performance of Windows Movie Maker, the following system 

requirements are recommended:  

• A 1.5 gigahertz (GHz) processor, such as an Intel Pentium 4, an AMD Athlon 

XP 1500+, or equivalent processor  

• 256 megabytes (MB) of RAM  

The following software is required to play back a movie:  

• Microsoft Windows 98 or later or Windows NT® 4.0 or later  

• Software that can play Windows Media Video (WMV) files, such as Microsoft 

Windows Media Player 7.0 or later (Windows Media Player 9 Series is 

recommended to optimize movie playback)  
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Supported file types 

You can add content to your Windows Movie Maker project either by capturing content 

directly in Windows Movie Maker or by importing existing digital media files. The 

content you capture in Windows Movie Maker is saved in Windows Media Format. 

However, you can also import existing Windows Media-based content as well as other 

common file formats. 

You can import files with the following file name extensions into Windows Movie 

Maker to use in your project:  

• Audio files: .aif, .aifc, .aiff .asf, .au, .mp2, .mp3, .mpa, .snd, .wav, and .wma  

• Picture files: .bmp, .dib, .emf, .gif, .jfif, .jpe, .jpeg, .jpg, .png, .tif, .tiff, and .wmf  

• Video files: .asf, .avi, .m1v, .mp2, .mp2v, .mpe, .mpeg, .mpg, .mpv2, .wm, and 

.wmv  
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Keyboard shortcuts 

Task Shortcut key 

Create a new project CTRL+N 

Open an existing project CTRL+O 

Save a project CTRL+S 

Save a project with a new name F12 

Save a movie CTRL+P 

Capture video CTRL+R 

Import an existing digital media file CTRL+I 

Undo the last action CTRL+Z 

Redo the last undone action CTRL+Y 

Cut  CTRL+X 

Copy CTRL+C 

Paste CTRL+V 

Delete DELETE 

Select all clips CTRL+A 

Rename a collection or clip F2 

Clear the storyboard/timeline CTRL+DELETE 

Show or hide the storyboard/timeline CTRL+T 

Zoom in on the timeline PAGE DOWN 

Zoom out on the timeline PAGE UP 

Add selected clips to the storyboard/timeline CTRL+D 

Play video in full screen ALT+ENTER 

Set start trim point CTRL+SHIFT+I 

Set end trim point CTRL+SHIFT+O 
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Clear trim points CTRL+SHIFT+DELETE 

Split a clip CTRL+L 

Combine contiguous clips CTRL+M 

Nudges clip to the left CTRL+SHIFT+B 

Nudges clip to the right CTRL+SHIFT+N 

Play or pause clip SPACEBAR 

Stop playback on the storyboard/timeline CTRL+K 

Play content on the storyboard/timeline CTRL+W 

Rewind content on the storyboard/timeline CTRL+Q 

Back CTRL+ALT+LEFT ARROW 

Forward CTRL+ALT+RIGHT ARROW 

Previous frame ALT+LEFT ARROW 

Next frame ALT+RIGHT ARROW 

Display Help topics F1 

Select previous item (on a timeline track, on the 

storyboard, or in the Contents pane) 

LEFT ARROW 

Select next item (on a timeline track, on the 

storyboard, or in the Contents pane) 

RIGHT ARROW 

Select item above (on a timeline track or in the 

Contents pane) 

UP ARROW 

Select item below (on a timeline track or in the 

Contents pane) 

DOWN ARROW 

Go to the first item (on a timeline track, on the 

storyboard, or in the Contents pane) 

HOME 

Go to the last item (on a timeline track, on the 

storyboard, or in the Contents pane) 

END 

 

________________________________well done  


